
 

Multiviewers V8 6 

 
 
 
 
 
 

 
The TSL Tally and  

UMD Configuring Program 

 
Multiviewer Information 

 
 
 
 
 
 

Television Systems Limited. 
Vanwall Road, Maidenhead, Berkshire, SL6 4UB 

Telephone +44 (0)1628 676200, FAX +44 (0)1628 676299 

U
SO

 R
ES

TR
IT

O



 

Multiviewers V8 6 

 
 
 
Contents 
 
 
1 Barco Vivaldi 
 
2 Evertz MVP Maestro  
 
3 Evertz VIP  
 
4 Evertz Quattro  
 
5 Leitch NeoSuite   
 
6 Miranda K2 / Alto  
 
7 Oxtel Presmaster 2 
 
8 Zandar VMX/DX/MX/Fusion Pro  
 
9 Vutrix Displays 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Notes 
 
Much of the material in this section has kindly been provided by the multiviewer 
manufacturers. 
 
Always use the manual supplied with the multiviewer for the latest information and to check 
pin functions. 
 
• Almost all current units accept TSL UMD protocol. 
• The cable details in the boxes refer to the cable connectors. 
 
 
 

U
SO

 R
ES

TR
IT

O



 

Multiviewers V8 6 

1 Barco Vivaldi 
 
Set the RS485/RS422 Vivaldi II port to MPK protocol and the address to match that show in 
TallyMan for the quad-split display. The port must be  configured as 1 x 4. 
 
The address field at the bottom of the list of four fields in the Vivaldi set-up is the one that 
must match TallyMan first address for that particular Vivaldi’s address -  decimal or hex. 
 
All other ports must be set to a different protocol, and are not used. 
 
 
Remote 1 Socket 
 

TM1 / TM2 
RS-232 

   VIVALDI 
RS-232 

D9 Socket    D9 Plug 
2 → RX → 8 

3 ← TX ← 7  

5  GND  6 

 
RS 422 Cable Connections  
 

TM1 / TM2  VIVALDI RCDS BUS D9M 
  Control Port 

(D9 Plug)  (D9 plug) 

3 ← 4 

8 ← 2 

7 → 5 

2 → 3 

6,4  GND 7 

 
 
TM1 / TM2 RS 422 Control Port Details 
 

CONTROL RS 422 / RS485 CONNECTORS 
D9 SOCKETS 

1 0v 6 0v 
2 TX- 7 TX+ 
3 RX+ 8 RX- 
4 0v 9 0v 
5 -   

 
 
 
Communication Parameters 
 
• 38K4 baud  
• 8 data bits  
• Even parity 
• 1 start bit  
• 2 stop bits 
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2 Evertz MVP Maestro  
 
 
 
Notes 
 

• The cable details in the boxes refer to the cable connectors. 
 
• The multiviewer is plugged into any UMD display port on the TM1 / TM2 or PSU-22. 

 
• If the TCP/IP UDP link is used the IP settings must all be in the same group for all units 
(TMx,  Mixer and Evertz). 

 
• The appropriate software may have to be loaded into the multiviewer if it has not 
already been delivered with the software installed. 

 
The Evertz manual covers this procedure. 
 
 
 

Evertz MVP  
 

These multiviewers are treated exactly like a D16C UMD as far as cabling and TallyMan  
configuration is concerned. However, to make the on-screen graphics look right, a  
Multiviewer box should be selected from the TallyMan list and Multiviewer PIPs added into 
the box.  

 
Interface cable between the System Controller RJ45 connector and the Evertz input 
connector.  
 
 

TM1 / TM2 
Or PSU-22 

EVERTZ 
MULTIVIEWER 

BREAKOUT 
CONNECTOR 

RJ45 Plug Screw Terminals 
1 4 
2 4 
3  

4 (TX+) 8 (CTS / RX+) 
5 (TX-) 6 (RX / RX-) 

6  
7  
8  

 
 
RJ45 pin details 
 
 View from the back. 
 Cable entry. 
 
        
RJ45 Connector on the cable 
 
 
 
 
Set jumpers J34 and J33 on the PPV module(s) to RS422.  

1 2 3 4 5 6 7 8  
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Use HyperTerminal to set the PPV port to TSL UMD parameters:  
 
Terminal Program settings: 
 
• Baud: 115200  
• Data Bits: 8  
• Parity: None  
• Stop Bits: 2  
• Flow Control: None  
 
Use Menu 4 to set the UMD protocol to TSL and menu 5 to set the TSL UMD data rate etc:  
 
• Baud 38k4  
• Data Bits: 8  
• Stop Bits: 1  
• Parity: Even  
• Comms: RS 422/ RS 485  

  
 
Mnemonics  
 
The MVP can have up to three sets of mnemonic boxes per PIP.  TallyMan can have only one  
with the associated tallies.  
 
Set the PIP to have the matching Address (called Protocol in the Evertz lists) as show in  
TallyMan by viewing View > Show Display Address.  Sixteen characters may be displayed 
and the MVP has the capability of displaying various fonts.  
 
Tallies  
 
Tally boxes may be added in the MVP set up screen and these should normally have the  
same address as the mnemonics box. It will be seen that the two tallies (two tallies max per  
PIP) are entered as Tally A and Tally B for the left and right tallies.  

 
 
 

 
 
 
 

U
SO

 R
ES

TR
IT

O



 

Multiviewers V8 6 

3 Evertz VIP  
 

These multiviewers are treated exactly like a D16C UMD as far as cabling and TallyMan  
configuration is concerned. However, to make the on-screen graphics look right, a  
Multiviewer box should be selected from the TallyMan list and Multiviewer PIPs added into 
the  
box.  
 
Interface cable between the System Controller RJ45 connector and the Evertz input 
connector.  
 
 

TM1 / TM2 
OR PSU-22 

EVERTZ 
MULTIVIEWER 

BREAKOUT 
CONNECTOR  

RJ45 Plug Screw Terminals 
1 6 
2 6 
3  

4 (TX+) 5 (RX+) 
5 (TX-) 4 (RX-) 

6  
7  
8  

 
 
RJ45 pin details 
 
 View from the back. 
 Cable entry. 
 
        
RJ45 Connector on the cable 
 
 
 
 
 
Use HyperTerminal to set the PPV port to TSL UMD parameters:  
 
Terminal Program settings: 
 

• Baud: 115200  
• Data Bits: 8  
• Parity: None  
• Stop Bits: 2  
• Flow Control: None  

 
Use Menu 4 to set the UMD protocol to TSL and menu 5 to set the TSL UMD data rate etc:  
 

• Baud 38k4  
• Data Bits: 8  
• Stop Bits: 1  
• Parity: Even  
• Comms: RS 422/ RS 485  

  

1 2 3 4 5 6 7 8  
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 4 Evertz Quattro  
 
 
Notes 
 
• The cable details in the boxes refer to the cable connectors. 
 
• The multiviewer is plugged into any UMD display port on the System Controller or PSU-22. 
 
• The appropriate software may have to be loaded into the multiviewer if it has not already 
been delivered with the software installed. 
 
The Evertz manual covers this procedure. 
 
 
These multiviewers are treated exactly like a D16C UMD as far as cabling and TallyMan 
configuration is concerned.   
 
Interface cable between the System Controller RJ45 connector and the Evertz input Aux I/O 
D25 connector.  
 
 

TM1 / TM2 
Or PSU-22 

EVERTZ 
MULTIVIEWER AUX 

I/O PLUG  

RJ45 Plug D25 Plug 
1 21 
2 21 
3  

4 (TX+) 17 (RX+) 
5 (TX-) 18 (RX-) 

6  
7  
8  

 
 
 
 
RJ45 pin details 
 
 View from the back. 
 Cable entry. 
 
        
RJ45 Connector on the cable 
 
 
 
 
 
  
Notes: 
 
The UMD must be entered into TallyMan as a 16 character display. 
 
 

1 2 3 4 5 6 7 8  
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To set the Evertz address etc: 
 

1. On the appropriate video card ( e.g. 7765 AVM-4-**) press the white button to call up 
the on-screen menu. 

2. Use the toggle switch to select Serial port. 
3. Press the white button again. 
4. Select Serial port configuration and using the toggle switch select TSL protocol 
5. Step up the menu to TSL protocol 
6. Select using the white button 
7. Select the Video source A address and set the address using the toggle switch 

shown on the TallyMan desktop for that particular “D16C” position. 
8. Set the other three address as required. 
9. Ensure that the centre and right link is made for RS422 working on the 3 pin link 

adjacent to TP8 on the upper left of the top board. 
 
 
Tallies 
 
If the tallies come up in incorrect colours, the background colour can be set using the white 

button and toggle switch as above. 
 

1. Select On-screen display configuration 
2. Select Text Burn-in properties  
3. Select Source  ID Colour 1 =Red 
4. Select Source  ID Colour 2 = Green 
5. Select Source  ID Colour 3 =Orange 

 
The tallies are normally as follows. 
 
A Red (left) tally will set the background to Red. 
A Green (right) tally will set the background to Green. 
Both tallies will set the background to Amber/Orange. 
 
 
 
 
 
Upgrading the Evertz software for TSL protocol  – please see the Evertz Manual for details: 
 
Briefly: 
 

1. Set jumper J15 on the appropriate card to Upgrade 
2. Attach the Evertz supplied cable to the 3 pin plug adjacent to the upgrd/run 

connector 
3. Run HyperTerminal 
4. Push in the card to the frame and the opening screen will be shown if all is OK. 
5. Run the upgrade program from the transfer File routine in HyperTerminal – use 

Modem X setting. 
6. Withdraw the card and set the link, J15, to Run. 
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5 Leitch NeoSuite   
 
 
Note:   Leitch multiviewers read TSL UMD Protocol directly. 
 
 
Please consult the Leitch Manuals for appropriate pin connections and functions. 
 
Use Com 23 on the Leitch unit which must be set to read TSL UMD protocol 
 
 
RJ45 Connections from TSL equipment. 
 
 

PIN FUNCTION DIRECTION 

1 0V GND 
2 0V GND 
3 RX- IN 
4 TX+ OUT 
5 TX- OUT 
6 RX+ IN 
7 +24V OUT 
8 +24V OUT 

 
 
Interconnecting cable required 
 

PIN FUNCTION DIRECTION LEITCH 
D9S
KT 

FUNCTION 

1 0V GND 5 0V 
2 0V GND -  
3 RX- IN 2 TX- 
4 TX+ OUT 3 RX+ 
5 TX- OUT 8 RX- 
6 RX+ IN 7 TX+ 
7 +24V OUT -  
8 +24V OUT   
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6 Miranda K2 / Alto  
 
 
 
Notes 
 
• The cable details in the boxes refer to the cable connectors. 
 
• The multiviewer is plugged into any UMD display port on the System Controller or PSU-22. 
 
• A RS422 to RS232 converter is required for each Miranda K2 unit for easy configuration. 
 
• The appropriate software may have to be loaded into the multiviewer if it has not already 

been delivered with the software installed. 
 
• Build the TallyMan / TallyMan desktop display using Multiviewer from the UMD list.  
 
 
Miranda K2 
 
These multiviewers are treated exactly like a D16C UMD (Dynamic 16 in TallyMan) as far as 
cabling and TallyMan / TallyMan configuration is concerned.  Select Insert > Display and 
then select Multiviewer in the TSL program from the Displays list. 
 
Set the address in the Miranda unit to match the Address shown in TallyMan / TallyMan for 
the UMDs in the multiviewer list for that particular K2 multiviewer. 
 
Cable Requirements 
 
For Miranda RS232 connections. 
 
To avoid reconfiguration of the Miranda unit it is recommended that a RS422 to RS232 
converter box be used for each Miranda K2, such as the K2 ADE made by KK Systems and 
that the Miranda RS232 port is used.   
 
Note that this unit must be powered.  If it is plugged in directly to the Miranda K2 it will pick up 
power from Miranda Pin 4 (DTR line). 
 
The DIP switch settings are: 
 

1 2 3 4 5 6 

OFF ON OFF ON ON ON 

 
  
URL: http://www.kksystems.com/ 
 
 

 
 

KK SYSTEMS LTD  
P.O. Box 2770 
Brighton 
West Sussex 
BN45 7ED 
United Kingdom 

Tel: +44 1273 857185 
Fax: +44 1273 857186 

Please check the KK web site 
for other distributors.  
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The Miranda RS232 connections are: 
 
 

Pin Function 

1 DCD 
2 RX 
3 TX 
4 DTR 
5 Gnd 
6 DSR 
7 RTS 
8 CTS 
9 RI 

 
TSL TM1 / TM2  RJ45 or PSU-22 RJ45 Connector 
 

Pin Function 

1 0V 
2 0V 
3 RX- 
4 TX+ 
5 TX- 
6 RX+ 
7 +24V 
8 +24V 

 
TallyMan TMC-1 only RS422 Connector – non standard pin out. 
 
 

Pin Function Pin Function 

1 TX- 6 RTS- 
2 TX+ 7 RTS+ 
3 RX+ 8 CTS+ 
4 RX- 9 CTS- 
5 0v    

 
Miranda RS422 connections. 
 
 

TM1 / TM2 
Or PSU-22 

Miranda Unit 
RS422 UMD Port 

RJ45 Plug D9  Plug 
1 (0V) 4 (0V) 
2 (0V) 6 (0V) 
3 (RX-) 8 (TX-) 
4 (TX+) 7 (RX+) 
5 (TX-) 2 (RX-) 
6 (RX+) 3 (TX+) 
7 (+24V)  
8 (+24V)  
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Only the TSL TX+ and TX- pair are relevant in this application. 
TSL UMD Data Specification. 
 

• RS 422  
• 8 bit data 
• 1 stop bit 
• even parity 
• 38.4k baud 

 
 
 
RJ45 pin details on the System Controller or PSU-22. 
 
 
 View from the back. 
 Cable entry. 
 
        
RJ45 Connector on the cable 
 
 
 
  
 
 
 
 
 

1 2 3 4 5 6 7 8  
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Diagram courtesy of Image Technics. 
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The following is courtesy of Miranda. 

TSL,  Andromeda,  Encoda and Kalypso  

TSL, Andromeda, Encoda and Kalypso are third-party devices that supply Kaleido with tally 
information and dynamic text for UMDs, Text Labels and Tallies.  

The interface between Kaleido and third-party devices is managed using Miranda's iControl 
system. Each such device is addressed by Kaleido using its MirandaLongID, which is an 
address within the iControl protocol. This address must be installed manually on the Kaleido 
by the user.  

The address can be found using the iNavigator application, which is part of iControl, once the 
device is installed on the network.  

All components in a Kaleido layout that obtain information from a third-party device require 
the Service ID of that device to be entered at their configuration panel. The Service ID is 
either the Miranda LongID, or an alias that points to the LongID. An alias is a user-selected 
term that is easier to remember and enter than the LongID.  

To install a device's LongID (and preferably an alias) on the Kaleido-K2, proceed as follows:  

1. First, get the service's Long ID: 

• From your Kaleido-K2's desktop, double click on the icon "My Computer". 
• Navigate to "C:\iControl\Startup\" and open the file "Kaleido.log" using the Notepad 

(right click on the "Kaleido.log" file and select "Notepad" from the "Open With" menu).  
• Within Notepad, press "Ctrl-F" or select "Find..." from the Edit menu and in the "Find 

What" section enter "serviceAdded called for ID:". 

Each entry found will give you the Miranda Long ID of an iControl service found on the 
network. Continue looking through the file until you find the Long ID of your TSL, 
Andromeda or Encoda. 

 
The Long ID of a TSL should have the following form:  
10.9.8.7_COM1_TSL 
The Long ID of an Andromeda should have the following form:  
10.9.8.7_COM1_UMD_00_SLOTXX_MODULEIDXXXX 
The Long ID of an Encoda should have the following form: 
10.9.8.7_COM1_ENCODA 
The Long ID of a Kalypso should have the following form: 
10.9.8.7_COM1_KALYPSO 

2. Find the file C:\Icontrol\Startup\KG2Config.xml on the Kaleido frame and open it in 
Notepad. The service for the third-party device will be added in the section 
<OtherServices>, which will look like this: 

<OtherServices> 
<!-- Use the same syntax as above to find services other than Kaleido Services --> 
<!-- AlphaNumeric Label is permitted here, example below:--> 
<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> --> 
</OtherServices>  

3. Supported third-party devices will then be added into this section as per the indicated 
format. See the Installation Guide for more detailed instructions on installing and 
connecting to third-party devices. 
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TSL (supplies dynamic text for UMDs and Text Labels, and Tally statuses) 
<Service ServiceLabel="TSL" id="192.168.1.2_COMX_TSL" />  
Where: 

• TSL (within the quotes) is the alias (and could be any user-selected name); 
• 192.168.1.2 is the IP address of the TSL (as found using iNavigator);  
• X in COMX_TSL is the COM port number assigned to the TSL service during the 

installation. 

Andromeda (Phillips) (supplies dynamic text for UMDs and Text Labels, and Tally 
status). 
<Service ServiceLabel="PHIL" id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" />  
Where: 

• PHIL (within the quotes) is the alias (and could be any user-selected name); 
• 10.3.4.9 is the IP address of the Kaleido (use the actual IP address of your Kaleido),  
• COM1 must be replaced by COM2 if you have configured the system to use the 

COM2 port, 
• The remainder of the text is exactly as shown 

Encoda (supplies dynamic text for UMDs and Text Labels) 
<Service ServiceLabel="ENC" id="192.145.10.2_COMX_ENCODA" />  
Where: 

• ENC (within the quotes) is the alias (and could be any user-selected name); 
• 192.145.10.2 is the IP address of the Encoda (as found using iNavigator);  
• X in COMX_ENCODA is the COM port number assigned to the Encoda service 

during the installation. 

Kalypso (supplies dynamic text for UMDs and Text Labels, and Tally statuses). 
<Service ServiceLabel="KAL" id="10.5.4.8_COM1_KALYPSO" />  
Where: 

• KAL (within the quotes) is the alias (and could be any user-selected name); 
• 10.5.4.8 is the IP address of the Kalypso (as found using iNavigator);  
• COM1 must be replaced by COM2 if you have configured the system to use the 

COM2 port, 
• The remainder of the text is exactly as shown 

If all four of these services are installed (as an example), the "Other Services" section 
becomes: 
 
<OtherServices> 
<!-- Use the same syntax as above to find services other than Kaleido Services --> 
<!-- AlphaNumeric Label is permitted here, example below:--> 
<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> -->  
<Service ServiceLabel="TSL" id="192.168.1.2_COM4_TSL" /> 
<Service ServiceLabel="PHIL" 
id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" />  
<Service ServiceLabel="ENC" id="192.145.10.2_COMX_ENCODA" /> 
<Service ServiceLabel="KAL" id="10.5.4.8_COM1_KALYPSO" /> 
</OtherServices>  

Now, you may enter the alias TSL, PHIL, ENC or KAL as the ServiceID in configuration 
panels for UMDs and Text Labels to identify one of these third-party devices as the source of 
their dynamic text.  
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You may choose any convenient name for the alias; for example, the Philips alias could be 
Dyn:  

<Service ServiceLabel="Dyn" id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" 
/> 

And:  Install the TSL service using the installer (Kaleido-K2 CD-ROM) 

TSL and Andromeda Installation 
 
TSL and Andromeda are third-party devices that supply Kaleido-K2 with dynamic text for 
UMDs and Text Labels. 
 
The interface between Kaleido and third-party devices is managed using Miranda’s iControl 
system. Each such device is addressed by Kaleido using its MirandaLongID, which is an 
address within the iControl protocol. This address must be installed manually on the Kaleido 
by the user. 
 
The address can be found using the iNavigator application, which is part of iControl, once the 
device is installed on the network. 
 
All components in a Kaleido layout that obtain information from a third-party device require 
the Service ID of that device to be entered at their configuration panel. The Service ID is 
either the Miranda LongID, or an alias that points to the LongID. An alias is a user-selected 
term that is easier to remember and enter than the LongID. 
 
To install a device’s LongID (and preferably an alias) on the Kaleido, proceed as follows: 
 
1. Use iNavigator to locate the device on the network, and note its address (see the 
iNavigator manual for more details). 
 
*** Please note, if iControl is not available to obtain the LongID use the format shown below: 
 
  For TSL protocol: 192.168.1.2_COMX_TSL 
  For Philips protocol:
 10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX 
 
2. Supported third-party devices will then be added into this section as per the indicated 
format. See the Installation Guide for more detailed instructions on installing and connecting 
to third-party devices. 
 
TSL (supplies dynamic text for UMDs and Text Labels) 
 
<Service ServiceLabel="TSL" id="192.168.1.2_COMX_TSL" />  
 
Where: TSL (within the quotes) is the alias (and could be any user-selected name); 
 192.168.1.2 is the IP address of the Kaleido that you are trying to add      
dynamic UMDs to by using a TSL UMD System Controller (as found using iNavigator);  
 X in COMX_TSL is the COM port number assigned to the TSL service during the 
installation. (COM1 is RS-232C and COM2 is RS-422). 
 
 
Andromeda (Philips) (supplies dynamic text for UMDs and Text Labels) 
 
<Service ServiceLabel="PHIL" id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" />  
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Where:  PHIL (within the quotes) is the alias (and could be any user-selected name); 
  10.3.4.9 is the IP address of the Kaleido (use the actual IP address of your 
Kaleido),  
 COM1 must be replaced by COM2 if you have configured the system to use the 
COM2 port. 
 The remainder of the text is exactly as shown 
 
 
If both of these services are installed (as an example), the “Other Services” section becomes: 
 
<OtherServices> 
<!-- Use the same syntax as above to find services other than Kaleido Services --> 
<!-- AlphaNumeric Label is permitted here, example below:--> 
<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> -->  
<Service ServiceLabel="TSL" id="192.168.1.2_COM4_TSL" /> 
<Service ServiceLabel="PHIL" 
id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" />  
</OtherServices>  
 
Now, you may enter the alias TSL as the ServiceID in configuration panels for UMDs and 
Text Labels that receive their dynamic text from this TSL decoder. You may enter the alias 
PHIL as the service ID in configuration panels for CC text, CC status indicators, and VChip 
status indicators that receive their information from this Andromeda (Phillips) decoder.  
 
You may choose any convenient name for the alias; for example, the Phillips alias could be 
CC:  
     
<Service ServiceLabel="CC" id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" 
/>   
 
3. Find the file C:\Icontrol\Startup\KG2Config.xml on the Kaleido frame and open it in 
Notepad. The service for the third-party device will be added in the section <OtherServices>, 
which will look like this: 
 
<OtherServices> 
<!-- Use the same syntax as above to find services other than Kaleido Services --> 
<!-- AlphaNumeric Label is permitted here, example below:--> 
    <Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> --> 
replace xxx.xxx.xxx.xxx with the long ID alias created above 
</OtherServices>  
 

 Configuring the UMD for dynamic text: 
 
The attributes of a UMD are adjustable using its configuration panel in KEdit. To access the 
panel for a UMD within a Monitor: 
 
1. Double-click on the Monitor in which the UMD is located. The Monitor’s border will turn 
yellow, indicating it may be edited. 
 
2. Click on the UMD. Control points will appear at the corners and the center of the long 
side, showing it is selected.  
 
NOTE: at this point the UMD may be positioned (click on the UMD and drag) and scaled (click 
and drag a control point) within the Monitor. It cannot be moved outside the Monitor boundary 

3. Open the configuration panel for the UMD by pushing F5, or from the Configuration 
Panel item in the View menu after having selected the source window in the Kaleido-K2.  
 
Three tabs are available to set different parameters for the UMD.  
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UMD Dynamic Text:  
 
Click the selection button to select Dynamic Text 
See XXXXXXXXXX (Gateway, TSL and Andromeda dynamic data sources) for an 
explanation of this portion of the panel. 
 
The KEdit window will show the ID, Address and Link order of the source text. The Monitor 
Wall output of the Kaleido will show the text originating at that source. 
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Configuring the Tallies: 
 
 
Explanation: 
 
To assign a TSL tally to a Kaleido-K2 Tally indicator, you must create an alarm monitor first. 
 

Alarm Browser 
Access Kaleido-K2’s alarm resources by opening the Alarm Browser from the View menu, or 
by using F7. The browser shows a list of existing Alarm Monitors, and the Alarm Inhibition 
group to which each alarm monitor is associated, if any. Click on the header of either column 
to sort the table in ascending order according to that column.  
 
 
New:  Click New to add a new alarm 

monitor to this list. A blank Alarm 
Monitor control panel will open.  

 
Edit:  Click on an existing alarm monitor to 

select it, then click Edit (or, double–
click on the existing alarm monitor) 
to modify it. The Alarm Monitor 
control panel will open, containing 
the current definition of the selected 
Alarm Monitor. 

 
Remove:  Click on an existing alarm 

monitor to select it, then click 
Remove to delete it 

 

 

 
 

Alarm Monitor 
The Alarm Monitor control panel provides all the necessary resources to create and manage 
alarms on the Kaleido-K2. 
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Alarm Monitor Name:  Type a name for this Alarm 

Monitor in the box.  
 
 
Type: Click inside the Type column and select  the 

Tally type.  
 
 

 
 
 
 
Alarm Setting –Tally 
 
Service ID:  Enter either the Miranda LongID or the Alias 

for the service that will be monitored by this 
alarm. 

 
Sources of dynamic text (TSL and Andromeda) 
incorporate Tallies in their data streams which are used 
to transmit error status information. Consult their 
manual for instructions on how to set up this aspect of 
their system, and to determine what values to enter in 
the Text Address and Level data entry boxes in this 
panel so that Kaleido can recover the error status 
information. 
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Then you need to assign the Tally to a status video border, a UMD or a tally component. 
 
 
Video Border Tab 
 
Border Colour:  
A border around the periphery of the video screen 
is used to show alarms associated with the 
screen’s video. For each of the four possible alarm 
states, select the colour of the border (if enabled 
under Video Window Frame; see below). For the 
Warning and Error states, border flashing can be 
turned on or off by clicking the box. 
 
• The Colour Fill icon shows the colour currently 
selected for the border. 
• Click on the down-arrow beside the Colour Fill 
icon to open a colour selection window and choose 
a different colour. 
 
Assign Alarm Monitor:  
Select an alarm monitor to be assigned to this 
video component from the pull-down list of 
available alarms. The status of the alarm will be 
shown by the border.  
 
 

 

 
 
 

 
UMD Alarm Tab 
 
Display Options:  
For each of the four possible alarm states, select 
the colour of the UMD background and the colour 
of the text, and whether the Transparency feature is 
enabled. You can also specify if the background will 
flash for Error and Warning states. 
 
Select a background colour from the list in the pull-
down box. 
  
Click on the down-arrow beside the Text Colour 
icon to open a colour selection window to choose a 
different font colour. 
 
Assign Alarm Monitor:  
Select an alarm monitor to be assigned to this UMD 
from the pull-down list of available alarms. 
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Tally Assignment Tab 
 
Tally State Colours:  
Click the Select… button beside each of the four 
states to select the Tally colours that will represent 
that state. A Tally Colours selection box will appear, 
offering eleven options (bright and dark versions of 
five colours, plus invisible. You can also specify if the 
Tally will flash for all states. 
 
Tally Assignment:  
The pull-down list includes all available options. 
These are:  
• All of the available GPI inputs  
• All of the defined alarms 
• None (i.e. unassigned) 
 
To configure a dynamic tally from TSL, Andromeda or 
other services, you must create an alarm monitor and 
assign the alarm monitor to the Tally. See the section 
on alarm monitors (XXXXXXXXX). 
 
The shape of the icon in the tally color window 
reflects the type of tally being configured (Left Tally in 
the example here), as the same configuration panel 
opens for all four types (top, bottom, left and right). 
 
Transparency:  
Use the slider to select a transparency for the tally. 
The transparency is only seen when the tally is 
overlaid on a video screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100% 
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And: 
 
Dynamics UMDs/Text Label & Kaleido-K2 
 
1- On the Controller rear connector panel, there are 2 communication ports; 

  
1) RS-422/485 : For  connecting the Kaleido-RCP or 

other  
remote devices.  
*If this communication port is used, note that you will 
have to stop MT_RCP service on the Kaleido frame.  
It is recommended to set it to manual as well.  
It will be found using the SERVICES icon on the 
desktop. 

 
2) RS-232 : To connect to router status information 

sources for tracking UMDs. 
 
 

 
 
 
 
 
 
 
 

2- Use the Kaleido-K2's CD and locate the folder named "Options" 
Next step is to install the right service. 2 choices are available: 
 
1) TSL ("TSLSetup_2_00.exe") 
2) Thomson-Andromeda ("AndromedaSetup.exe") 
 
*During the installation you would need to select the appropriate communication port; com1 or 
com2.  Refer to first section for detail. 
 
3- Need to start the dedicated service. 
 
Use the SERVICES icon found on the desktop. 
  
Start the service (MT_TSL or MT_ANDROMEDA) then go to Properties and set it to 
automatic. 
 
4- Take note of the Kaleido's IP address. 
 
To locate it : right click on My Network Places found on the desktop, select Properties, right 
click on Local Area Connection, select Properties, choose Internet Protocol (TCP/IP) and 
select Properties.  
 
5- Need to locate the KG2Config.xml file. 
 
 Found in C:\iControl\Startup 
 Open the document then on the top menu select View, Source. 
 On the document, you will need to edit a line.  
 Locate the section "OtherServices" then this line: 
 <Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> 
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 Copy the line and paste it under then replace with appropriate information. 
 Example 1 : <Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> 
   <Service ServiceLabel="TSL" id="10.0.3.22_com1_TSL" /> 
  
    Kaleido's IP address 
 
Example 2 :  
<Service ServiceLabel="ANDROMEDA" id="10.0.3.22_com1_ANDROMEDA" /> 
 
 Save the file then close it. 
 

! 
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6- Kaleido Editor software (KEdit) on remote computer. 
 
 On the selected layout, click on the corresponding UMD. 
 Select on the top menu, View, Configuration panel or F5 
 
 - UMD window will open, set it to UMD Dynamic Text. 
 
 - Need to insert the Service ID: TSL or ANDROMEDA 
  
- Text Address : address from the converter box. 
- Level :  0 = first 8 characters 
1 = last 8 characters 
2 = all 16 characters 
 
 
 
 
 
  
 
 
 
 

U
SO

 R
ES

TR
IT

O



 

Multiviewers V8 6 

 
Alto Details – courtesy of Miranda 
This is taken directly from the Miranda publication. 
 
• Select RS422B port to be TSL protocol 
• Set XP machines to have the Classic desktop setting otherwise some screens may not 

show correctly 
 
11 TSL and Andromeda 
 
TSL and Andromeda are third-party devices that supply Kaleido with tally information and 
dynamic text for UMDs and 
Text Labels. Kaleido-Alto features a built-in engine to distribute TSL or Andromeda data to 
pre-configured 
components in a layout. Incoming data using TSL or Andromeda protocol is fed through one 
of the serial ports (see 
section 4.2 Paremeters Settings) of the unit. 
 
11.1 Configuring a UMD or Text Label Component to be modified by a TSL Device 
 
The following explanations will guide you through the steps to take to configure a Text Label 
Component so its 
displayed text will be driven by a TSL device. These steps are executed from KEdit. 
x Select a Text Label Component. 
x If the Configuration Panel is not already displayed display it by selecting “Configuration 
Panel” from the “View” 
menu or by pressing “F5”. 
x In the Assignment tab, select “UMD Dynamic Text” or “Label Dynamic Text”. 
x In the “ServiceID” field type “TSL” in capitals. 
x In the “Text Address” field enter the address to associate with this Text Label. This value 
must range between 1 
and 127. 
x In the “Level” field enter the value that represents what you want to use from the data 
located at the specified 
address: 
x 
0: you want to use the 16 characters 
x 1: you want to use the first 8 characters 
x 2: you want to use the last 8 characters. 
x Click on the “Apply” button to apply your modifications to the Text Label Component. 
The Component is now configured to take the text to display from the specified address of the 
TSL device and to 
display a part of or all the characters found at this address. Considering that the TSL device is 
already available to.User’s Manual 
Kaleido-Alto | 53 
the Kaleido-Alto, all there is to do now to see the text appearing in the UMD or Text Label is 
to export the layout to 
the Kaleido-Alto. 
 
11.2 Configuring Dynamic Tallies from the TSL Device 
 
To configure the Tallies sourced from the TSL, you must first create Alarm Monitors. These 
Alarm Monitors can then be assigned to any components that have alarm behavior in your 
layout i.e. Text Label color, UMD color, Tally, Video border or Status Indicators. 
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Creating an alarm monitor 
 
Access Kaleido-Alto’s alarm resources by opening the Alarm Browser from the View menu, or 
by using F7. The browser shows a list of existing Alarm Monitors, and the Alarm Inhibition 
group with which each alarm monitor is associated, if any. Click on the header of either 
column to sort the table in ascending order according to that column. 
Create a new Alarm: Click New to add a new alarm monitor to this list. A blank Alarm Monitor 
control panel will open. 
 
Alarm Setting – Tally 
 
Click inside the Type column and select the Tally type. 
Service ID: Enter “TSL” in capitals for the service that will be monitored by this alarm. 
Text Address: Enter the address of the dynamic data [between 1 and 127]. 
Level: Enter the level of the dynamic data. 
The level can be 0, 1 or 2 and have a particular meaning. The TSL box has 4 Tallies per 
address, but the Kaleido-Alto is able to treat only 2 Tallies per address (one left and one 
right), so here is the rule followed to retrieve the Tally left and Tally right status: 
0 16 chars T1 or T3 T2 or T4 
1 First 8 chars T1 T2 
2 Last 8 chars T3 T4 
Create an Alarm Monitor for every Tally device to be displayed in the Kaleido-Alto layout. 
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TSL Guide  
 
Setting up a Miranda Alto – Software from 3.30. 
 
Set the Desktop on an XP configuring PC to Classic.  If you do not do this you may not be 
able to see some buttons in the Miranda KEdit Program. 
 
Note: 
 
The settings shown will allow split (Iso) tallying in TallyMan, using the Tally Bits set to Basic. 
 
Although split tally operation is shown here, the settings are good for tallies in a single 
channel such as Program, in TallyMan.   
 
These tests were carried out using the TallyMan  Program and Iso 1 channels. 
 
The settings below are shown for a TSL UMD address at 000. 
 
 

• Unlock the UMD. 
• Set the UMD to UMD Dynamic Text 
• Set the Service ID to TSL 
• Set the Text Address to +1 on the TSL TallyMan indicated Address.  Miranda has a 

+1 offset to the TSL Address. 
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• Unlock the left UMD 
• RH mouse click 
• Select New and give the tally setting a name for that PIP.  
• Select Tally from the list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Highlight on the tally line. 
• Click Edit 
• Enter the Service ID as TSL and give the Text address as for the UMD (TallyMan 

address +1) 
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You must end up with these settings for the LH tally in the Alto. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now set the colours 
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RH Tally 
 

• Do the same for the RH tally by using the same tally type for this PIP, shown as Split 
Tally here but note the reversed Severity settings in the Boxes.  Set these by clicking 
in the box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Now set the colours 
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If you have only red tallies from the Program channel, set these colours to red.  Iso tallying 
colour is shown. 
 
For the next PIP do the same but increment the Text Address and make a new tally with a 
new name for that monitor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press Apply and then Export to the Alto. 
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7 Oxtel Presmaster 2 
 
 
This information has kindly been provided by Miranda Technologies Ltd. 
 
Please inspect the Miranda manual for further information. 
 
The following lists the GPIs allocated on the Presmaster panel and on the PCS unit.  These 
allocations are fixed.  Tallies are available on the panel reflecting the state of the first eight 
sources only of the PGM and PVW buses.  Note that these tallies reflect the current state 
shown on the panel.  If a different channel is selected the state of these tallies may change. 
 
 
 

Summary of GPI/O functionality in Presmaster V3.0 - Revision 2 
 
All GPI/Os are active low, and momentary unless specified as 
latching. 
 
Prespanel 
 
Outputs (0-23) 
0    Latching PGM bus input selection (mapped to buttons) 
1    In a mix both should close 
2    In black all should release 
3   
4   
5   
6   
7   
8     Latching PST bus input selection 
9     In a mix both should close 
10   In black all should release 
11   
12   
13   
14   
15   
16  Take momentary 
17  DSK1 Live (latching) 
18  DSK2 Live (latching) 
19  DSK3 Live (latching) 
20  DSK4 Live (latching) 
21  VO1  Live (latching) 
22  V02  Live (latching) 
23  Alarm (OR of all possible alarms) U
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Inputs (24-31) 
24  Take button parallel 
25  Fade button parallel 
26  Silence button parallel     
27  VO1 button parallel  
28  VO2 button parallel  
29  Audio lead button parallel  
30  Audio lag button parallel   

 
PCS 
 
Outputs (0-23) 
0   channel changed 
1   chan 1 selected (latching) 
2   chan 2 selected (latching) 
3   chan 3 selected (latching) 
4   chan 4 selected (latching) 
5   chan 1 automation on/off (latching) 
6   chan 2 automation on/off (latching) 
7   chan 3 automation on/off (latching) 
8   chan 4 automation on/off (latching) 
23  Alarm (OR of all possible alarms) 

 
 

Inputs (24-31) 
24  chan 1 automation on/off 
25  chan 2 automation on/off 
26  chan 3 automation on/off 
27  chan 4 automation on/off 

 
 

The appropriate pins on the Presmaster must be wired to the required System 
Controller Tally Connector D37 inputs. 
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8 Zandar VMX/DX/MX/Fusion Pro  
 
 
 
Zandar Multiviewers now read TSL UMD Protocol directly.  These notes are for those earlier 
viewers that do not. 
 
Please consult the Zandar Manuals for appropriate pin connections and functions. 
 
 
 
 
RJ45 Connections from TSL equipment. 
 
 

PIN FUNCTION DIRECTION 

1 0V GND 
2 0V GND 
3 RX- IN 
4 TX+ OUT 
5 TX- OUT 
6 RX+ IN 
7 +24V OUT 
8 +24V OUT 

 
 
RS422 Connections from TSL TM1 and TM2  equipment. 
 
 

RS 422/RS485 CONNECTORS 
D9 SOCKETS 

PIN FUNCTION PIN FUNCTIO
N 

1 0v 6 0v 
2 TX- 7 TX+ 
3 RX+ 8 RX- 
4 0v 9 0v 
5 -   

 
 
RS232 Cable Connections from a RS422 outlet 
 
 

TM1 / TM2  Zandar 
D9 PLUG  D9 Com Socket 

2  2 
4 SCN 5 
8  3 
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RS485 Cable Connections for DX units 
 
 

UMD SYSTEM CONTROLLER   ZANDAR 
RS 422 

D9 Plug   D9 socket 
2 TX- → 2 

7 TX+ → 7 

4 GND  9 
8 RX- ← 8 

3 RX+ ← 3 

6 GND  6 

 
Notes For DX Units 
 
 

• Enter the Menu > Remote Setup 
• Press OK 
• Ignore the RS232 setting 
• Press OK 
• Set the RS422 baud rate to 9600 
• Press OK 
• Set CLI Port to RS422 
• Press OK 
• Set System to the required ID – default is 00 
• Press OK 

 
Use a 1:1 cable between the TM1 / TM2 port and the Zandar’s RS422 port. 
 
The settings in the Zandar unit will be set to:    
 
 

• 9600  
• No Parity  
• 8 Data Bits 
• 1 Stop Bit 

 
 
Allow about 12 seconds for the initial update.  This will occur quickly if, say, a tally is activated 
– otherwise background updating will occur. 
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Zandar DX Units from software version 4.06. are set to receive TSL UMD Protocol. 
 
Later DX units are set on the Aux Port to read TSL UMD Protocol.  The DX unit emulates 16 
(DX16) or 4 (DX4) 8 character UMDs with a single tally each. 
 
It is important to note that the UMD/Tally Emulator board in the Zandar units is optional for the 
DX units and will not be in all systems.  Please contact Zandar for further information. 
 
From System Setup, the router settings on the DX unit must be set to: 
 
Router Use:  YES 
Baud:  38400 
Port :  RS422(85) 
Start #: 00 (default)  <set to first UMD address for the multiviewer as shown by TallyMan>. 
Use PIP 1:  TRUE 
Etc for the other PIPs 
 
Only Tally 1 is used. 
 
 
 Observe the following pin functions and make a cable to interface to a TSL UMD Display Port 
or a Power Supply PSU-22. 
 
Cable Requirements 
 
 
 

TM1 / TM2 
Or PSU-22 

 Zandar DX 
RS 422 AUX Port 

RJ45  D9 AUX socket 
5 (TX-) → 2 (RX-) 

4 (TX+) → 7 (RX+) 

2 (0V)  4 
3 (RX-) ← 8 (TX-) 

6 (RX+) ← 3 (TX+) 

1 (0V)  6 
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Tally Configuration. 
 
The tallies mapped to VMX Zandar units will provide the following colours. 
 
Tally 1 (left) Red 
Tally 2 (right) Green 
Tally 1+2 Amber 
 
For DX units the mnemonic will change colour from White to Red.  
 
 
The tallies mapped to non TSL UMD Protocol DX Zandar units will provide the following 
colours: 
 
Tally 1 (left) White letters, Red background 
Tally 2 (right) Black letters, Green background 
Tally 1+2 Black letters, Yellow background 
 
 
 
Zandar MX Units 
 
These units are simpler in that there is no addressing to be set.  The System Controller will 
have a RS232 interface provided. 
 
RS232 Cable Connections 
 
 

TM1 / TM2 
RS-232 

FUNCTION FROM THE 
SYSTEM CONTROLLER 

ZANDAR MX 
MULTIVIEWER 

D9 Socket  D9 RS232 Socket 
2 � RX 3 
3 TX � 2 
5 GND 5 

 
 
 
 
If more than one unit is to be used in a system the RX, TX and GND wires are taken to the 
first unit and thereafter only the TX and GND cables are carried on to subsequent units.  In 
this arrangement updating may be somewhat sluggish. 
 
This might be used where, for example a quad spilt was required on two units, unit one set to 
inputs 1, 2, 3, & 4 and unit two to inputs 5, 6, 7, & 8. 
 
Tally colours are as follows: 
 
Tally 1 (left) White letters, Red background 
Tally 2 (right) Black letters, Green background 
Tally 1+2 Black letters, Yellow background 
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Zandar Fusion Pro  
 
RS422 Cable Pin out details 
 
 

TM1 / TM2 
 

FUNCTION FROM THE 
SYSTEM CONTROLLER 

ZANDAR FUSION 
MULTIVIEWER 

D9 Plug  D9 RS485 Skt 
2 TX- � 8 
7 TX+ � 3 
8 � RX- 7 
3 � RX+ 2 

4, 6 GND 5 

 
Use Com 2 
 
Set the Fusion Pro as follows: 
 

• Select TSL Protocol for the UMD setting. 
• Remote Serial  
• Select Com 2 to RS485  
• Select Baud to 38400  

 
ZANDAR COM 2 PIN FUNCTIONS 

1 NC 6 NC 
2 TX+ 7 TX- 
3 RX+ 8 RX- 
4 NC 9 0v 
5 GND   

 
To set the first UMD address put in the address for the first UMD in Z Config. 

• Connect to unit via Z Config. (via LAN or RS232) 
• Go to system setup and then to the Com’s Port Tab. 

 

 
 
The Fusion Pro will accept up to 16 characters. 

The first UMD address in the 
TallyMan driver 

 

Screen picture courtesy of 
Zandar Technologies 
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9 Vutrix Displays 
 
Pin out information kindly supplied by Vutrix. 
 

VUTRIX  MONS GPI RJ45 
PORT 1 

SIGNAL/IDENT 

Pin 1 TALLY GREEN SCREEN 1 

Pin 2 TALLY GREEN SCREEN 1 

Pin 3 TALLY GREEN SCREEN 2 

Pin 4 TALLY GREEN SCREEN 2 

Pin 5 TALLY GREEN SCREEN 3 

Pin 6 TALLY GREEN SCREEN 3 

Pin 7 TALLY GREEN SCREEN 4 

Pin 8 TALLY GREEN SCREEN 4 

  

VUTRIX MONS GPI RJ45 
PORT 2 

SIGNAL/IDENT 

Pin 1 TALLY RED SCREEN 1 

Pin 2 TALLY RED SCREEN 1 

Pin 3 TALLY RED SCREEN 2 

Pin 4 TALLY RED SCREEN 2 

Pin 5 TALLY RED SCREEN 3 

Pin 6 TALLY RED SCREEN 3 

Pin 7 TALLY RED SCREEN 4 

Pin 8 TALLY RED SCREEN 4 

  

VUTRIX MONS RS442 
UMD DATA "D" 

MALE/FEMALE 9 PIN. 

SIGNAL/IDENT 

Pin 1 RX- 

Pin 2 RX+ 

Pin 3 N/C 

Pin 4 N/C 

Pin 5 GND 

Pin 6 N/C 

Pin 7 N/C 

Pin 8 N/C 

Pin 9 N/C 
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